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1 Installation du logiciel

Pour commencer linstallation, double cliquer sur I'exécutable.

-

*  MNom Modifié le Type Taille
XDesignerPlus(V2.6.34)5etup 30/10/2013 10:39 Application 219820 Ko
B xDesignerPlus(V2.6.37)5etup 11/03/2014 10:53 Application 221 817 Ko

Une pré-installation se lance.

XDesignerPlus - InstallShield Wizard |

Preparing Setup
Pleasze wait whils the InstallShield YWizard prepares the setup.

=DezignePlus Setup is preparing the [nstallS hield wizard, which will guide you through the rest
of the setup process, Please wait,

InstallShield

Cancel

Une fois la pré-installation terminée, cliquer sur « next ».

r,. B’
XDesignerPlus - InstallShield Wizard =

Welcome to the InstallShield Wizard for
XDesignerPlus

The InstallShield Wizard will install <D ezignerPlus on your
camputer. Tao continue, click Hest.

e
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Entrer votre identifiant et le nom de votre société et cliquer sur « next ». Cliquer de nouveau
sur « next » pour commencer l'installation des drivers.

Touch Operaticn Pannel Driver Setup ﬂ
i —

Setup Status

Touch Operation Pannel Driver is configuring your new software installation.

InztallS hield

Une fois l'installation terminée, cliquer sur « finish ».
N ——— | -

Install Successful

Jatus
Touch Operation Pannel Driver Setup

The Touch Operation Pannel Driver Package has been
installed from your computer.

< Back
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Sélectionner installation compléte et cliquer sur « next », puis cliquer sur « instal ».

Sl

XDesignerPlus - InstallShield Wizard -

Setup Type

Select the setup twpe to install.

Pleaze zelect a zetup type.

@ Complete

Al program features will be installed, (Requires the most disk space.]

() Custom

Select which program features pou want installed. Becommended for
adwanced users.

Attendre la fin de l'installation.

KDesignerPlus - InstallShield Wizard

Setup Status

The InstallShield Wizard is instaling XDezignerlus

Installing

AL S ndustredPipetpipe D034 ellowtA16ln_Pi003 w19 0bmp

Cancel

A la fin de I'installation cliquer sur « finish ».
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2 Utilisation du logiciel

2.1 Création d’un projet

Une fois le logiciel ouvert, créer un nouveau projet en cliquant sur « new project ».

Draw(D) Tag(I)} Tool{Q) Transmission(R) Window(¥W) Help

[=] XDesignerPlus
[File(E) | Edit(E) View(\) Project(P)
Eh New
g Open Project Ctrl+0
g Add Project
&= Save Project Ctr+S
Save As Project Shift+Ctri+S
@ Close
&% Close Project All
Print Ctri+P
Recent File
B Exit Alt+F4

»| G5 New Project
&1 NewBase Screen
v [ EA NewWindow Screen
2 New Sub Screen

[ C)
@ -3 - &

3& ﬁﬂ + Name
g 3l o7 oot 5

"'

2.2 Sélection d’'un modele

Dans la liste suivante, sélectionner votre pupitre, puis cliquer sur « next ».

Project Setting @
HMI/ PLC Uint
Series XTOP Series Vendor Lsis
Model KTOPO4TW-UD PLC Model Glofa GM (LINK)
TOP
Series Model
XTOP Series Name R i Color Memory
ATOP Series XTOPOSMQ-ED(-E) 320 = 240 Mono16Level &M
- XTOPOSTQ-ED{-E) 320 * 240 65536Color (]

HTOP Series
KTOPDBTV-ED{-E) 640 * 480 B65536Color 26M
XTOP10TS-ED{-E} B00 * 600 65536Color 26M
XTOP10TV-ED{-E) 640 * 430 65536Color 26M
XTOPOSKMQ-S00 320 * 240 Mono16Level 26M
XTOPO5S0-SD 320 * 240 65536Color 26M
XTOPOSTQ-SD 320 * 240 65536Color 26M
XTOPOETS-SD B00 * 600 65536Color 26M
XTOPOBTV-5D 640 * 480 B3536Color 26M
XTOP10TS-SAJSD B00 * 600 65536Color 26M
KTOP10TV-SA/SD 640 * 430 65536Color 26M
KTOP12TS-LA{-E) 800 * 600 65536Color 26M
KTOP12TS-S5A5D 800 * 600 65536Color 26M
XTOP15TX-SA/SD 1024 * 768 65536Color 26M
XTOPD4TW-UD, |[[480=272 [B5536Color [BAL
KTOPOTTW-LD(-E} 800 * 430 65536Color 26M
KTOPOTTW-UD B00 * 430 65536Color 26M
KTOP10TW-UD{-E) B00 * 430 65536Color 26M

Back || wext ok || cancel

Tutoriel XDesignerPlus

Page 6



SERAD Tutoriel

Motion Control | XDesignerPlus(V2.6.37)

noeoqed KM

271, Route des Crétes _
44440 TEILLE Tutoriel R1727

Dans le menu suivant, sélectionner le périphérique qui communiquera avec le pupitre.

Project Setting (557
HMI/ PLC Uint

Series XTOP Series. Vendor MODBUS

Model XTOPO4TW-UD PLC Model WODBUS

PLC

Wendor Model

LSS MODBUS

SAMSUNG MODBUS SLAVE

MITSUBISHI MODBUS-TCP (Master/Client)
OMRON MODBUS-TCP (Slave/Server)
Rockwell (Allen Bradly)
MODBUS

SIEMENS

GE Fanuc

HITACHI

KDT Systems.

KOYQ
PANASONIC(Matsushita}
Honeywell

FATEK

YOKOGAWA
TFASKAWA

VIGOR

EMOTIONTEK
SCHNEIDER

DELTA

Fun

KEYENCE -

| »

m

Back || Wext ok || cancel

Exemple pour une communication avec un variateur SERAD de type IMDL :

Project Setting @
HMIJ PLC Uint
Series XTOP Series Vendor WODBUS
Model XTOPOATW-UD PLC Model MODBUS
PLC Option
PLC Info
Vendor Name :  MODBUS
PLC Name : MODBUS
PLC Alias : IMDL
PLC Comm Info
Station Number(PLC) 1 pt
procotol RTU -
Wirite Command Preset Multiple Registers (0x10)
Read Bit Size 16 -
Device Read Type Continuous Read -
Max Read Count 125 +
Swap Option{Read) Big Endian Format(4,3,2,1) hd
Swap Option{Write) Big Endian Format(4,3,2,1} bl
|:| Use Float data (32bit) word swap

Back | | Next oK | | Cancel
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2.3 Menu du projet

Une fois le projet ouvert, sur la gauche de I'écran on peut voir :

[Project Manager] [List Windaw]

4z

B8

=% Screen

------ = 2-page texte

------ = 2-page manu
-2 Window Screen

------ M 65400-texte

-[El Sub Screen
EI-- Global Screen
E| Master Screen

| Top Frame
Left Frame
] Right Frame

2 Botom Frame
=-45% Global Setting

4% Text Table

----- [F] Logging Setting
----- & Alarm Setting
Recipe Setting
-2 Script Setting

----- =] Message Table

Jﬁ Event Log
eS| Images List

Tutoriel XDesignerPlus

Les pages afficheur

4/

= 65533—mdp‘

“fd 1-MasterScreenl®

Les écrans de saisie
(Mot de passe, valeur
ou texte)

Les bandeaux

Les réglages

—
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2.4 Bouton

Pour ajouter un bouton, il faut cliquer sur « touch ».

E’ XDesignerPlus - C:\Users\Christopl m

ject1.DPX

File(F) Edit(E) View(V) Project(P} Draw(D) Tag(T) Tool(Q) Transmission(R) Window(W) Help

=] @ Base Screen
CE 1-init
L [E 2-page2

@ Touch + Bit Lamp
@ Touch +Word Lamp
@ Touch + N Lamp

2-acae Pave g » : (ge [ge T < e o ®
na|4PegoR | sneasne [@E ¢ | EIAMLER | BEc b | BEOH0 (4

- vo-0-rav-208 (sfl@-8-8-% -B-2-2- aaq o
=] t-init |3-NewBaseSc.. | | |EE

- - @ word Lamp
[Project Manager] [List Window] 7151 |[2] - NewBaseScree @ NState Lamp =m =l 5=

B-6f) NEWPROJECT! | s Tmekear ||ids Toucn
=@ Screen e —

"[E) 3-NewBaseScreen2
) Window Sereen
Sub Screen
£33 Global Screen
£ @ Master Screen
. 0 1-MasterScreen]
- Top Frame
O Left Frame
+[O Right Frame
“..[0 Bottom Frame
=45 Global Setting
- Text Table
~[Z Logging Setting
-3 Alarm Setting
| Recipe Setting
~#35) Script Setting
=) Message Table
JB. Event Log
{Z Images List

Une fois le bouton créé, double-cliquer dessus pour le modifier. Pour son apparence aller
dans I'onglet « display » puis dans « shape type ». Sélectionner ensuite bitmap, puis cliquer
sur le petit logo a droite pour ajouter une image (glisser I'image dans la zone en haut et
cliquer sur « ok »). Pour y mettre du texte il faut cocher I'option « caption ».

Touch =)
PreView Display | iterLock | Operation | information
VISUAL
Shape Type None Edge
Hone Edge Wute On Touch
[ Rectangle
et G Circe Buzz On (TouchPressed)
—— TOUCH COLC i sitmap
[ tioPa - Touch Fill Style  X0R Color -
— 1 A —
——
[ T——==|| cAPTION
Touch Use Caption
Touch Tag Type
] Touch
Lamp
@8
Securtty
Securtty Level 0 =

Tutoriel XDesignerPlus Page 9



SERAD

Motion Control

Tutoriel

XDesignerPlus(V2.6.37)

271, Route des Crétes

44440 TEILLE

Tutoriel

R1727

Aller ensuite dans I'onglet opération pour régler les parametres. Si vous voulez faire une
opération sur un mot ou un bit il faut aller dans I'onglet « word operation ». Une fois
I'opération terminée cliquer sur « ADD » puis sur « OK ».

Touch

PreView

|[ Display | interLock | Operation | information

OPERATION
Push on delay

Mo Operation

Default

< [m

| * Down ||

o T x100ms

DataType | Expression

| & n

- Up |

+
I modry || Eetere |

| Bt state [ word Operation | key mput | spe

write data size 16 bit - operand data size 15 bit -
Touch Tag Type - : . ) §
Data T @ DEC ) UDEC & HEX &) BCD ) FLOAT
Touch SEE= - - - - -
= =
[ Lamp D PLCT  ~ 400001 g= -
) ~0ic=
@B R —— == —
: O PLC1  ~| 400001 =)l
© word e
_State
Security
Security Level 0 +
Ve N\
Help (F1) ( oK ' Cancel

Si vous voulez faire un changement de page, il faut préalablement avoir déclaré une page
(clique droit sur « base screen » et sélection ensuite d'un numéro de page et d'un nom).
Aller ensuite dans I'onglet « special function ».

=

Touch (=)
PreView || Display I InterLock I Operation | Information
OPERATION
Push on delay 0 S x100ms
No Operation | DataType | Expression
Default
« [ m— ¢

—

a e Add H»Mcdify ” @Delete

| Bit State I Word Operation I Key Input | Specidl

EXIT

\-State

Security
Security Level 0

-
-

Category
Touch Tag Type SCREEN -
Touch Special operation
[ Lamp EXIT
@ Bit Previous Screen

Screen Change
Window Move
Window Popup(Toggle)
Security Level

Exit from Run Screen, to Menu Mode.

Tutoriel XDesignerPlus

Previous screen : pour faire
un retour a la page
précédente.

Screen change : pour
changer de page. Il faut
choisir la page que I'on
souhaite afficher.

Une fois 'opération terminée
cliquer sur « ADD » puis sur
« OK ».
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2.5 Commutateur
ur ajouter u utateur il faut sélecti «Tou i ».
Pour ajouter un commutateur il faut sélectionner « Touch+ BitLam
XDesignerPlus - C:i\Users\Christophe\Deskiopitestitest m2ilNewProject1.DPX
[=]
File(F) Edit(E) View(V) PFOJEC‘E(P) Draw(D)} Tag(T) ToollQ) Transmission(R) Window(W) Help
ES'-_‘LDIEJ E@M{ﬁ 20 .@_& .DND 5 Name
e 4PBEHOE HEARLEE -tﬁ B € 3 0% 0 osRe o
é‘\i—.J*U*E%E'.ﬂMﬂ 5|=~de:-?57@1@,% = . & - b
| 2-page2® | 1-imt | 3-page3 |e54001 ® BitLamp
. . @ Word Lamp
[Pro?ln.av:tManager] [List Window] 12 Elz-paglﬂ' @ S —
=48 Nf':PROJECT] | 8 Trackdit || (s Toucn '_|
B8 Screen - — r
; E| Base Screen % Touch + BitLamp
: |:| 1-init &M Touch +Word Lamp
-[E 2- pagez"‘ @ Touch + N Lamp

Dans 'onglet « Display » sélectionner « bitmap » pour choisir les images du commutateur,
une pour OFF et une autre pour le ON en cliquant sur le bouton a coté de Bitmap. Une fois
les deux images sélectionnées, modifier la valeur dans « lamp adress » par votre adresse de
commutateur. Aller ensuite dans I'onglet « operation » et sélectionner 'adresse de votre

commutateur et cliquer sur « ADD » puis sur « OK ».

==

Touch Lamp

PreView | Display | InterLock | Operation

OPERATION

Informatien

Push on delay 0  x100ms
No Operation | DataType | Expression
< [m] 3
| » Down || A Up | q (o) Add @Modiﬁa || EIpeket= |

| Bit State I Word Operation | Key Input I Special on

Touch Tag Type ADDRESS
[
Touch PLCA ~ 100001 E|
Tor
Lamp
OPERATION
@ Bit - -
i © oN (©) OFF
() Word _ _
@ Reverse () Momentary
) N-State
Security
Security Level 0 st

Cancel

Tutoriel XDesignerPlus
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2.6 Voyant

Pour ajouter un voyant, il faut aller choisir la « bit lamp ». Sélectionner ensuite les deux
images, une pour le bit & 0 et une autre pour le bit a 1. Y associer enfin la variable puis

valider avec « OK ».

Bit Lamp 5
PreView | Display I Information |
VISUAL
Shape Type |2E] Bitmap - Image Transparent
OFF LAMP SETUP
LampAddress o DL~ 401294.02 1=
- =
OFF ON
e — E—
Effect None - Effect None -
| on |
i T CAPTION
= [7] use Caption
[ Touch
Lamp
@ Bit
) Word
() N-State
Security
Security Level 0 s
]

Tutoriel XDesignerPlus
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2.7 Saisie de variable

Texte

Pour taper un texte dans un champ, il faut cliquer sur « Keypad Display (string) ».
Dans I'onglet « address », sélectionner I'adresse ou vous voulez rentrer votre valeur. Aller
ensuite dans l'onglet « display » pour régler la police.

Numérique

Pour taper une valeur dans un champ, il faut cliquer « Keypad Display (Numeric) ».
Dans l'onglet « address », sélectionner l'adresse ou vous voulez rentrer votre valeur.

|E| KDesignerPlus - C:\Wsers\Christophe\De sktop\testite st m2ilHewProject!.DPX
File(F) Edit(E) View(V) Project(P) Draw(D) Tao(T) ToollQ) Transmission(R) Window(W) Help

fub-_d'uoEi._?n fE@LNJ{'ﬁ? 20 .%. % Name + | Tablel

ra DRHEOR HHBBBE .;@ H EAmuEe | e
- vo-o-rav.ame s-alje-a-e-".0-x- iq
[x[ 2-page2 | -t | 3-page3 |65400-Tenk.. E Numeric

[Project Manager] [List Window] Ll @Zpagez a4 String EHE

— L._-I Keypad Display (Numeric)
1] Keypad Display (5tring)

E-4) NEWPROJECT! B

EI % Screen
1.;Il Base Screen

Tutoriel XDesignerPlus Page 13
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2.8 Afficher une variable

Texte

Pour afficher un texte, il faut cliquer sur « String », puis dans I'onglet « adress » sélectionner
la valeur que I'on souhaite afficher. Puis dans 'onglet « Display » pour régler la police.

Numérique

Pour afficher une valeur, il faut cliquer sur « Numeric », puis dans I'onglet « adress »

sélectionner la valeur que I'on souhaite afficher.

@ XDesignerPlus - C:\Wsers\Christophe\Desktopitestitest m2ilNewProject1.DPX
Flle(F) Edit(E) View(V) Project(P) Draw(D) Tag(T) ToolQ) Transmission(R) Window(W) Help

20 .e'g . 5 Name

- B Keypad Display (Numeric)

=45 NEWPROJECT1
@ ) “ HH Track Edit ||I|ﬂl *i Keypad Display (String)

EI & Screen

@B -BgAE & E@Nkﬁgiii v | Tablet
ﬁmm { P0G | FEBRE® .;ﬁ LR
W -No-o-rav.-ame (s-alje-a-e-".8-xw- &g
|E] 2-page2* |  l-init | 3-page3 |65400-TenK.. L Numeric

[Project Manager] [List Window] 1% |[2] 2-pagez* & String = (=] B

EI @ Base Screen

: = 1-init

= 2-page2*
= 3-page 3

i 52 Window Screen

Tutoriel XDesignerPlus
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2.9 Simulateur

Le Logiciel XDesignerPlus Dispose d'un simulateur. Pour lancer le simulateur cliquer sur
« Tool » puis « Run Simulator ». Le simulateur se lance automatiquement.

E‘ XDesignerPlus

Fie(F) Edit(E) View(V) Project{P) Draw(D) Tag(T)

Tool(0) | Transmission(R) Window(W) Help

[

‘B-aEe  EENG D
SBe@EEE BEWS
NE-Q-RaV-ED

[Project Manager] [List Window]

Rz

] Cross Reference(C)
Address Converter(A)
B8 Screen Manager(S)
[E! CF-Recipe Maker(K)
B Screen PreviewZ)
Image Font Change
f Text Table Converter

™ PDF Image Converter(}

& My Button Maker(M)
@ Image Library(B)
[ ProjectImage Tool(J)

Run Simulator

=
3
=
&
3

T

@ u
1 I:l‘
B

Fi2

Make TopView Client
B3 Edit Option(N)

Pour utiliser le simulateur cliquer directement sur les pages afficheurs. La partie de droite
permet de visualiser les états et valeurs des variables de la page active. Pour arréter le
simulateur fermer directement la fenétre.

' simulator (=] =] =
File Action Apout
a @ @ 100 3
Address
. sErRAD |
o b i AL -
Address Fiter
Device ALL -
Address Name ~ ALL ™ Address M|
Type ALL -
Address w* ASC A

Sort By

Current Address List =
Ho ‘Address ‘Sia(ns ‘Type

< [m] »

Debug List

Tag | wiatch List

No ‘Screenname ‘Tang ‘Type

@ Outills de visualisation

Tutoriel XDesignerPlus

Page 15




SERAD Tutoriel e

Motion Control | XDesignerPlus(V2.6.37)

271, Route des Crétes }
44440 TEILLE Tutoriel R1727

2.10 Transfert dans le pupitre

Une fois vos pages afficheurs créés, vous pouvez les charger dans le pupitre. Pour cela
cliquer sur « transmission » puis « build and transfert » ou appuyer sur F9. Une fenétre
s’ouvre et le projet se compile.

S

[Ver 2.44.25.0]

Dot tum offthe HMI power and unplug the LISB cable while connecting wth HM|

[ENTER]=Transfer, [ESCI=Exit
Down/Up File

&, pown | 6 17 |

Download File(F)

CAProgram Files (:86)M2I CorpWDesignePIus\TEMPITEST M2 TRI | File Select

Transmission Status
100 %

outan |

Ensuite cliquer sur « transmit » puis patienter le temps du chargement. Une fois le projet
chargé dans le pupitre, vous entendrez un « BIP ». Sur le pupitre cliquer sur la croix en haut
a droite pour fermer la fenétre de réglages et accéder a vos pages écran.

2.11 Mise sous tension du pupitre
Démarrage automatique du projet

Si vous voulez arriver directement sur les pages de votre projet sans passer par la fenétre
systéme du pupitre :

Aller dans l'onglet setup, puis le numéro 1 « power ON mode ». Cliquer dessus et
sélectionner « run » puis valider avec OK. Appuyer ensuite sur la croix en haut a droite.

Démarrage automatique sur fenétre systéeme

Si au démarrage votre projet se lance directement et que vous souhaitez retourner dans les
réglages de la fenétre systéme du pupitre, suivre la procédure :

Mettre hors tension le pupitre. Le remettre sous tension et appuyer plusieurs fois dans
le coin en haut a droite jusqu'a I'affichage de la fenétre systeme.

Tutoriel XDesignerPlus Page 16
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3 Communication pupitre/variateur IMD

3.1 Communication en RS232

L’exemple suivant est réalisé en RS232 sur la liaison native du variateur.

Paramétrage du variateur

Entrées / sorties codeur multifonctions

Motion control
El Liaizon RS 232 de base

Yitezse [Baud) 19200
Farité Sanz
Timeout [mz) 10

D écimal/Flottant Décimal

Irverzion de 'ordre des mote Ol
Liaizon extension
Générateur

Note : la liaison native du variateur correspond au connecteur X1.

Paramétrage du pupitre

Les pages de paramétrages sont accessible via Project > Project property

Tutoriel XDesignerPlus

PLC Info
Vendor Name : MODBUS Organization
PLC Name : MODBUS Serial Master
PLC Alias : PLC1
PLC Comm Info
Station Number(FLC) 2 ot
procotol RTU -
Write Command Preset Multiple Registers (0x10) ~
Read Bit Size 16 -
Device Read Type Continuous Read -
Max Read Count 125 s
Swap Option(Read) Big Endian Format(4,3,2,1) -
Swap Option(Write) Big Endian Format(4,3,2,1) v
[T]iuse Float data (32bit) word swap!
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Les paramétres de la communication du pupitre doivent étre semblables aux paramétres du

variateur.

HMI Setup I Sepcial Buffer Sync ‘

Use HMI Setup

System Setup I PLC Setup I Device Manager | Interface
* Network
-IP address 192 7 188 10 tw0 f
- Subnet mask 255 +|l255 s|l2s5 2|0 -
- Gateway 192 > 188 > 0 = -
* Communication Port
+COM1 +COM 2
-Boud Rate 38400 - Boud Rate 19200 -
- Data Bit: 8 - Data Bit: 8 it
- Stop Bit : 1 - Stop Bit : 1 -
- Parity Bit : None - Parity Bit None B
- Signal Level RS-232C -
* HMI Alias
- Alias Name
* Buzzer
- Buzzer Sound Enabled - - Buzzer (Interlock) Disabled -
*Touch
- Touch Mode Normal - - Teuch Sensitivity Normal -

Tutoriel XDesignerPlus
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3.2 Communication en RS485
L’exemple suivant est réalisé en RS485 sur la liaison d’extension du variateur.

Paramétrage du variateur

Motion control

Liaizon RS 232 de basze

B Liaizon extension
Frotocole ligizon extenzion Modbus R5485
Irverzion de 'ordre des motz O
Witezze CAMNopen [Bitssz) Aucune

Timeout CAMapen [ms] 1]
Mombre réesszai SO0 Canlpe 0
YWitezze Modbus (B aud] 32400
Parité Sang
Tirmeaout [ms) 10
Drécimal/Flaottant D écimal

moss

Note : la liaison d’extension du variateur correspond aux connecteurs X2 et X3.

Paramétrage du pupitre

Les pages de paramétrages sont accessibles via Project > Project property
La station Number(PLC) correspond au numéro de nceud RS485.

PLC Info
Vendor Name : MODBUS Organization
PLC Name : MODBUS Serial Master
PLC Alias : PLC1

PLC Comm Info

Station Number(PLC) 2

1k

procotol RTU i

Write Command Preset Multiple Registers (0x10) *

Read Bit Size 16 -

Device Read Type Continuous Read -

Max Read Count 125 ot

Swap Option(Read) Big Endian Format(4,3,2,1) i
Swap Option(Write) Big Endian Format(4,3,2,1) bl

[[iuse Fioat data (32bit) word swapi
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Les paramétres de la communication du pupitre doivent étre semblables aux paramétres du
variateur.

HMI Setup | Sepcial Buffer Sync |

Use HMI Setup

System Setup | PLC Setup I Device Manager | Interface

* Network
- IP address 192 S 168 S 0 *[iq00 =
- Subnet mask : 255 3255 /256 7 O b
- Gateway : 192 S 168 3 0 =7 s
Communication Port
+COM 1 +COM 2
-Boud Rate 38400 " -Boud Rate : 38400 =
- Data Bit: 8 1 - Data Bit: 8 =
- Stop Bit 1 - - Stop Bit: 1 -
- Parity Bit: None N - Parity Bit None i
- Signal Level RS-485(2) -
* HMI Alias
- Alias Name
* Buzzer
- Buzzer Sound Enabled - - Buzzer (Interlock) Disabled -
* Touch
- Teuch Mede : Normal - - Touch Sensitivity Normal -

Dans les différents champs de saisie ou de lecture, il est possible de choisir vers quel
esclave on veut pointer. |l suffit de choisir le PLC correspondant au n° de nceud paramétré
dans la déclaration des esclaves.

Touch + Bit Lamp
| Preview Display | InterLock | Operation | Im)rmation |

VISUAL
Shape Type L Bitmap - Image Transparent
[ Mute On Touch

[T] Buzz On (TouchPressed)

LAMP SETUP

Lamp Address 1] LGt~ 457431.00 EE]
oK

PLC2
OFF Internal ON

Special \:\

Effect Symbol Effect  Mone -
Offset

CAPTION
Touch Tag Type [C] Use Caption
Touch

Lamp

Tutoriel XDesignerPlus Page 20
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3.3 Table d’échange Modbus variateur IMD

L’acceés a la table modbus se fait via le logiciel iDPL dans Aide > Aide modbus/CanOpen.

57488 |457489 [VIO Variable Integer N°0 1 |Uintlé FixedNormal [3200h 00h 3200h 0h
57489 457490 [VI1 Variable Integer N°1 1 [Uintlé FixedNormal [3200h 01h 3200h 1h
57490 [457491 [VI2 Variable Integer N°2 1 [Uintlé FixedNormal [3200h 02h 3200h 2
57491 457492 IVI3 Variable Integer N°3 1 [Uintlé FixedNormal [3200h 03h 3200h 3h
57741 457742 [V1253 Vanable Integer N°253 1 [Uintl6 FixedNormal [3200h [FDh 3200h [FDh
57742 1457743 [VI254 Vanable Integer N°254 1 [Uintl6 FixedNormal [3200h [FEh 3200h [FEh
57743 457744 [VI255 Varable Integer N°255 1 [Uintle FixedNormal [3200h [FFh 3200h [FFh
57744 457745 VL0 Vanable Long N°0 12 |[Umnt32 [Fixed[Normal |3300h 00h 13300h 0h
57746 457747 VL1 Variable Long N°1 |2 |[Uint32 [Fixed[Normal |3300h 01h 13300h 1h
57748 457749 VL2 Variable Long N°2 2 |Umni32 [Fixed[Normal |3300h 02h 13300h 2h
57750 1457751 [VL3 Varnable Long N°3 2 |Umni32 [Fixed[Normal |3300h 03h 13300h 3h
58250 |458251 [VL253 Variable Long N°253 12 |JUmt32 [Fixed|Normal |3300h [FDh 13300h [FDh
58252 1458253 I[VL254 Variable Long N°254 12 |Umt32 [FixedNormal [3300h [FEh 13300h [FEh
58254 |458255 [VL255 Vanable Long N°255 12 |Uwmnt32 [FixedNormal |3300h [FFh 13300h [FFh
58256 458257 VRO Vanable Real N°0 2 |[Umt32 FrxedNormal [3400h 00h 3400h 0h
58258 |458259 [VR1 Vanable Real N°1 2 |[Umt32 FuoeedNormal [3400h 01h 3400h 1h
58260 1458261 [VR2 Variable Real N°2 2 [Umt32 FixedNormal [3400h 02h 3400h 2
58262 1458263 [VR3 Variable Real N°3 2 [Umi32 FixedNormal [3400h 03h 3400h 3h
58762 |458763 [VR253 Variable Real N°253 2 |[Umt32 FixedNormal [3400h [FDh 3400h [FDh
58764 [458765 I[VR254 Variable Real N°254 2 [Umit32 FixedNormal [3400h [FEh 3400h [FEh
58766 |458767 [VR255 Varnable Real N°255 2 |[Umt32 FixedNormal [3400h [FFh 3400h [FFh

1280 401281 DRIVE FLAGS [Flags 1 |Uint8 [Show 1 Standard [6510h 06h

1281 401282 | POSITION INCREMENT [R.otor position 2 |Umt32)° 0.1 [Standard [6410h 01h

1283 401284 CURRENT VALUE ICurrent 2 |Float [A DPL [Standard [6078h 00h

1285 401286 | VELOCITY ACTUAL VALUE Speed 2 [Float DPL [Standard [606Ch 00h 606Ch j00h

1287 401288 | DRIVE_ENABLED [FeedBack drive Enable 1 |Uint8 [Yes/No 1 Standard [6041h 00h

1288 401285 FAULT STATUS [F zults 1 |Uint16|Show 1 Standard [2100h 01h

1289 1401290 | POSITION_ACTUAL VALUE [Position 2 [Float DPL [Standard [6064h 00h

1251 1401292 FOLLOWING ERROR ACTUAL VALUE [Following error 2 |Float DPL [Standard |60F4h 00h

1293 1401294 | DIGITAL INPUTS [Digital inputs 1 |Uint16 1 Standard |60FDh 00h

1294 1401295 | DIGITAL _OUTPUTS [Digital outputs 1 [Uintl6 1 Standard |[60FEh 01h 60FEh 01h

1295 1401296 CONSIGNE INPUT VALUE [Demand (Analog Input 1} 2 |Float [V DPL |Standard [6510h 42h

1267 401298 | LIMIT INPUT VALUE [Limit (Analog Input 2) 2 [Float [V DPL [Standard |6510h l15h

1299 1401300 OUTPUT VALUE [Output 2 |Float [V DPL [Standard [6510h [45h 6510h HAR

1301 401302 MASTER. ACTUAL VALUE MMaster position 2 [Float DPL |Standard [2750h 03h

Tutoriel XDesignerPlus
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3.4 Lecture et écriture de variables VI
Pour lire le VI5 (adresse modbus 457494) suivre le paramétrage ci-dessous.
Numeric @
Preview | Address I Case | Display I Information
ADDRESS
Read Address PLC1 - 457494 :ﬂ||
Default
Data Type DEC i Symbol
Data Size @ 16bit 32bit Swap
DATA PROCESSING
Feature Scaling
@ Murmeric String
Use Key input
Pour écrire dans le VI7 (adresse modbus 457496) suivre le paramétrage ci-dessous
Keypad Display (Numeric)
Preview Address I Input Mode: I Case I Display I Information |
ADDRESS
Data Address PLC1 ~ 457496 :?,ll
Ok
Display Mod
e R Data Type DEC v Symbol
Data Size @ 16Dbit 32bit d Swap
88
DATA PROCESSING
Input Mede | Data Scaling
-
Device(before) - = ]
N
Feature £
Displayiafter) ; =
@ Numeric String |
| Use Key input Input Limit

Tutoriel XDesignerPlus
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3.5 Lecture et écriture de variables VL

Pour lire le VL15 (adresse modbus 457775) suivre le paramétrage ci-dessous.

Numeric
Preview Address | Case | Display | Information |
ADDRESS
Read Address PLc1  ~ 457775 :§||
oK
Default
Data Type DEC b Symbol
Data Size 16Dbit @ 32bit Word Swap
DATA PROCESSING
Feature Scaling
@ Numeric String
Use Key input

Pour écrire dans le VL17 (adresse modbus 457779) suivre le paramétrage ci-dessous

| Keypad Display (Numeric)

Preview Address I Input Mode I Case I Display I Information |
ADDRESS
Data Address PLC1 ~ 457779 :§||

=K

Display Mode
Data Type DEC i Symbal

88 Data Size 16bit @ 32bit Word Swap
DATA PROCESSING
Input Mode | Data Scaling
il
Device(before) ] s 10 s
L
Feature ;
Display(after) b : 100 s
@ Mumeric String
V| Use Key input Input Limit
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3.6 Lecture et écriture de variables VR

Attention Il faut ajuster dans I'onglet display la virgule, en fonction de la précision des
flottants des variables VR. Dans I'atelier logiciel iDPL, aller dans le menu Options > Langage
iDPL > Compilateur. (Ex : pour une précision iDPL a 0.01 il faut mettre Décimal places a 2)

i

~ FontSize 3x3 0

Background

Numeric
Preview || Address | case | Display [ information
VISUAL
[oNON®) 4 5
QOO . Font Type System Font
Font Gothic(8x16)
| Default |
effect [] Transparent
FORMAT
[ Format Mask
5 5
Eeature Data Length
Decimal Places 2 =
@ Numeric _) String
[E1 fill in a blink by '0"
] Use Key input

Alignment

-
-

Cut length 0

[] Passwordiwith )

Pour lire le VR15 (adresse modbus 458287) suivre le paramétrage ci-dessous.

Numeric
Preview Address I Case | Display I Information
ADDRESS
QOO0 4 5 S—
00 . Read Address PLC1 -~ 458287 H|
oKm
| Default |
Data Type DEC ~ [ Symbol
Data Size _) 16bit @ 32bit [F] word Swap
DATA PROCESSING
Feature 7] Scaling
@ Numeric _) String
[] Use Key input

Tutoriel XDesignerPlus
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Attention Il faut ajuster dans 'onglet display la virgule, en fonction de la précision des
flottants des variables VR. Dans l'atelier logiciel iDPL, aller dans le menu Options > Langage

iDPL > Compilateur. (EX :

pour une précision iDPL & 0.01 il faut mettre Décimal places a 2)

Numeric E
Preview || Address | Case || Display | Information
VISUAL
o NON®) 4 5
QOO0 . Font Type System Font -
Font Gothic(8x16) * FontSize ax3 [
| Default |
effect [] Transparent
FORMAT
[7] Format Mask
5 = Alignment
Eeature Data Length g
Decimal Places 2 s Cut length ol &=
@ Numeric _J) Sfring
[T fill in a blink by ‘0" [ Password(with )
] Use Key input

Pour écrire dans le VR17 (adresse modbus 458291) suivre le paramétrage ci-dessous

Keypad Display (Numeric)

Preview

00

Display Mode

883.00

| Input Mode

@]
O

@]
Q00 .

Feature
@ Numeric _) Sfring

Use Key input

Tutoriel XDesignerPlus

Address | Input Mode I Case I Display I Information |
ADDRESS

Data Address PLC1  ~ 458291 :qu||

e

Data Type DEC b [ symbol

Data Size _) 16bit @ 32bit [7] word Swap

DATA PROCESSING

[7] Data Scaling

LI
L

L

I,
Display(after) ! 100 }

r
Device(before) ! 100 }

ik
4k

[7] Input Limit
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3.7 Lecture d’'un Parametre

Attention pour les paramétres il faut tenir compte de la colonne « scale » de la table

modbus du variateur pour ajuster la lecture ou I'écriture.

3.7.1 Exemple lecture position

Table modbus variateur IMD

|AdressModbus Adress Name Description Size] Type [Unit / ValuegScale| Access |Read IndexjRead Sub Indexl'
1289 1401290 POSITION ACTUAL VALUE Position 2 [Float DPL [Standard (50640 00k
1291 1401292 | FOLLOWING_ERROR_ACTUAL VALUE Erreur de poursuite 2 [Float DPL [Standard (§0F4h 0k
1293 1401294 DIGITAL INPUTS [Entrées TOR I [Uintl6 | [Standard |60FDE 00k

Pour la position (adresse modbus 401290), le placement de la virgule est a définir en

fonction de la précision iDPL (ici 0.01). Pour accéder a la précision iDPL, il faut aller dans
Options > Langage iDPL > Compilateur.

-

~ FontSize 3x3 0

Numeric
Preview || Address | Case | Display § Information
VISUAL
Q00 4 5
QOO . Font Type Systemn Font
Font Gothic(8x16)
| Default |
effect [] Transparent
FORMAT
[T Format Mask
5 =
e Data Length
Decimal Places 2 =
@ Numeric ~) String
[T fill in a blink by '0"
[[] Use Key input

Tutoriel XDesignerPlus

Alignment

Cut length L

[] Passwordiwith
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Numeric
Preview Address | Case | Display | Information
ADDRESS
QQO0 4 5 ~
QOO . Read Address PLC1 - 401290 Hll
v
| Default |
Data Type DEC *  [C] symbol
Data Size _) 16bit @ 32bit O] Word Swap
DATA PROCESSING
Feature [ Scaling
@ Numeric _! 5tring
[ Use Key input
Tutoriel XDesignerPlus Page 27
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3.7.2 Exemple lecture des défauts

Table modbus variateur IMD

IAdressiModbus Adress| Name Description Size| Type [Unit / Value{Scale] Access |Read Index/Read Sub Ind
1288 | FAULT_STATUS [Défauts 1 |Uintl6[Voir 1 Standard |2100h 01h
Sur tension it
Sous tension it 1
T it 2
Sur courant 1t 3
ICourt cirtcurt 1t 4
[Température IGBT it 5
[Température motens it &
[Erreur retour de position (resolveur, sincos. ...) it 7
[Paramétres incorrects it §
PModéle vanateur incorrect it 9
[Erreur iDPL it 10
[Erreur de poursuite it 11
[Erreur Flash it 12
[Erreur FPGA 1t 13
[Erreur sur Vitesse 1t 14
[Erreur retour de position saturé it 15
[Erreur alimentation 24V it 16
[Erreur écriture Memory Stick it 17
[Erreur Memory Stick corrompue it 18
[Erreur EtherCat it 19
[Erreur entrée Externe it 20

Pour le mot de défaut (adresse modbus 401289), il n’y a pas de virgule on récupére une
valeur qui correspond a la valeur des bits de défauts.

Numeric @

Preview | Address I Case [ Display }| Information
VISUAL
O0000
ORONORORS Font Type System Font -
Font Gothic(8x16) ~ FontSize ‘ 3x3 I |
| Default |
Text Color Background \:l
effect [7] Transparent
FORMAT
[7] Fermat Mask
5 = Alignment
Feature Data Length g
Decimal Places o S Cut length g -
@ Numeric _) 5tring
[T fillin a blink by '0° [C] Password(with )
[[] Use Key input
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Numeric
Preview Address I Case I Display I Information
ADDRESS
Q0000
ONONONORS Read Address PLC1  ~ 401289 =)
| Default
Data Type DEC ¥ [] symbol
Data Size @ 16bit ) 32bit [ wWord Swap
DATA PROCESSING
Feature [ Sealing
@ Numeric _! String
[[] Use Key input
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3.7.3 Exemple lecture position du rotor
Table modbus variateur IMD
AdresgModbus Adress Name Description |Si1 Type |Unit / Valu Scale| Access tﬂxad [ndeliRead Sub Inde;xr
1281 {01282 POSITION INCREMENT Position du foter D JUit3 0.1 Btandard [B4100  [0lh
1283 401284 | CURRENT VALUE Courant 0 [Float A DPL [Standard |07 |00h
1285 401286 | VELOCITY ACTUAL VALUE Vitesse 0 [Float DPL [Standard [§06Ch  |00h
1287 (401288 | DRIVE ENABLED Retour drive actve | Ut OuNon |1 [Standard 50410 J0Ch

Pour la position du rotor qui est au format 32 bits (adresse modbus 401282), il doit y avoir 1
chiffre aprés la virgule dans l'affichage sur le pupitre car la précision est de 0.1 (voir colonne

Scale).
Numeric
Preview | Address | Case | Display || Information
VISUAL
. 5 Font Type Systern Font -
Font Gothic(8x16) ~ FontSize | 3x3 0 ‘
Default |
Text Color Background @
effect [F] Transparent
FORMAT
[T] Format Mask
5 = Alignment
e Data Length g
Decirmal Places 1 = Cut length o -
@ Numeric _! 5tring
[T fill in a blink by 0 [T] Passwordiwith ")
[ Use Key input
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Numeric
Preview Address | Case | Display | Information
ADDRESS
0000 5 _
QOO0 . Read Address PLC1 ~ 401282 :E:||
oK"
| Default |
Data Type DEC * [ symbol
Data Size ) 16bit @ 32bit ETiy
DATA PROCESSING
Feature [7] Scaling
@ Numeric _) String
[T Use Key input
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3.8 Lecture et écriture a partir d’'un script

ATTENTION : bien penser a choisir la « Data Length »en fonction des variables utilisées

dans le script. Les variables utilisées dans un script doivent toutes étre de méme

format.

Script 16bits :

Ecriture du mot interne 1 du pupitre dans la variable VIO du variateur
Ecriture du mot interne 2 du pupitre dans la variable VI1 du variateur

|5 Script Setting =2 (5]
| @ New | @ Save | Q Delete ‘
GLOBAL Script(1) h Script ID 1 % Description
| | Description | verify | Creat
1 TRUE  2017/l| Trigger Condition | Interval Bit
1 > (*s00ms) (0 Sec)
Data Length 16 Bit ~ Functions handling date and time can be executed only in 32bit script
< i | b 1 |rDow:pLcl:4574891=[5W:00017;
| - | p— | 2 | [DW:BLC1:457490]1=[5SW:0002];
3
|Funcv| Math v| Logic v Addr
i)
}
endif
l[] if ()
}
else
Messages Condition Expression OK
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Script 32bits :

Ecriture du double mot interne 5 et 6 du pupitre dans la variable VL100 du variateur
Ecriture du double mot interne 7 et 8 du pupitre dans la variable VL101 du variateur

[o] script setting == X
| Q New | @ Save | @ Delete |
GLOBAL Script(1} - Script ID 1 % Description
| ID|Descripton | Verify | Creat
1 TRUE 2017- Trigger Condition | Interval Bit
1 % [*s00ms} (0 Sec)
Cata Length 32 Bit * Functions handling date and time can be executed only in 32bit script
4| T | b 1 |[DW:PLCl:457945]=[5SW:0005];
| - | - | 2 | [DW:PLC1:457947]1=[5W:0007];
|
‘Funu.'rvl Kath -l Logic v Addr 4
@ if()
}
endif
@ if
}
else
Messages Condition Expression OK
Close
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